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Paper Set 1 · 18 Jun 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
ଗୋଟି ଏ ଟାଙ୍କି ରେ ପାଇପ A ଓ ପାଇପ B ନାମକ ଦୁ ଇଟି  ପାଇପ ଥାଏ । ପାଇପ A ଟାଙ୍କି କୁ  6
ଘଣ୍ଟାରେ ପୂ ର୍ଣ୍ଣ  କରି ପାରି ବ, ଯେତେବେଳେକି  ପାଇପ B ଏହାକୁ  8 ଘଣ୍ଟାରେ ପୂ ର୍ଣ୍ଣ  କରି ପାରି ବ ।
ତୃ ତୀୟ ପାଇପ C ଏକ ଆଉଟଲେଟ ପାଇପ ଅଟେ ଯାହା 12 ଘଣ୍ଟାରେ ପୂ ର୍ଣ୍ଣ  ଟାଙ୍କି କୁ  ଖାଲି
କରି ପାରି ବ । ଯଦି  ତି ନୋଟି  ପାଇପ ଏକାଠି  ଖୋଲାଯାଏ, ତେବେ ଟାଙ୍କି ଟି  ପୂ ର୍ଣ୍ଣ  ହେବା ପାଇଁ
କେତେ ସମୟ ଲାଗି ବ?

A.  D. 4.5 ଘଣ୍ଟା

B.  B. 4.8 ଘଣ୍ଟା

C.  A. 5.2 ଘଣ୍ଟା

D.  C. 5.8 ଘଣ୍ଟା

✓

Q2 Quant
A shopkeeper sells an item for ₹2,988 and incurs a loss of 17%. What
was the cost price of the item (in ₹)?

A.  D. 2,555

B.  A. 3,500

C.  B. 3,600

D.  C. 3,700

✓

Q3 Quant
A, B and C start a business. A invests ₹60,000 for 12 months. B
invests ₹45,000 for 12 months. C joins after 4 months with ₹30,000
and stays till year end. If the total profit at the end of the year is
₹125,000, find C’s share.

A.  ₹10,000

B.  ₹15,000

C.  ₹20,000

D.  ₹25,000

✓

Q4 Quant
The amount ₹644 is divided among X, Y and Z in such a manner that
X : Y is 3 : 7 and Y : Z is 5 : 6. What is X’s share?

A.  B. ₹105

B.  D. ₹214

C.  C. ₹193

D.  A. ₹161

✓

Q5 Quant
A train travels 132 km, the first 60 km at a certain speed and the
remaining distance at a speed of 8 km/hr more than its previous
speed. If it takes 3 hours for the train to complete the journey, find
the speed (in km/hr) in the first part of the journey.

A.  A. 38

B.  D. 40

C.  C. 42

D.  B. 45

✓

Q6 Quant
There are 1020 students in a school, of which 600 are girls. What is
the ratio of the number of boys to that of girls in the school?

A.  D. 5 : 7

B.  C. 10 : 9

C.  A. 7 : 10

D.  B. 11 : 15

✓

Q7 Quant
ନି ମ୍ନ ଲି ଖି ତ ତଥ୍ୟର ମଧ୍ୟମା ନି ର୍ଣ୍ଣ ୟ କର ।
ସମ୍ଭାଗ ବି ସ୍ତାର 0-8 8-16 16-24 24-32 32-40
ବାରମ୍ବାରତା 4 6 8 5 7

A.  D. 17

B.  C. 19

C.  A. 21

D.  B. 23

✓

Q8 Quant
If the ratio of two numbers is 9 : 5, and their HCF is 6, then their LCM
is:

A.  C. 270

B.  D. 311

C.  B. 288

D.  A. 301
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✓

Q9 Quant
Amit invested equal amounts at simple interest and compound
interest (compounded annually) for 2 years at the same rate of 8%
per annum. At the end of the period, the difference between the
interests earned was ₹96. What was the amount (in ₹) invested in
each case?

A.  D. 15,000

B.  A. 12,000

C.  C. 16,000

D.  B. 18,000

✓

Q10 Quant
ତ୍ରି  ଭୁ ଜ ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସତ୍ୟ ଅଟେ?
(a) ଦୁ ଇଟି  ବାହୁ ର ସମଷ୍ଟି  ତୃ ତୀୟ ବାହୁ ର ସମତୁ ଲ୍ୟ ଅଟେ ।
(b) ଦୁ ଇଟି  ଅନ୍ତଃସ୍ତ କୋଣ ସମକୋଣ ହୋଇପାରନ୍ତି  ।
c) ସର୍ବୋ ଚ୍ଚ ବାହୁ ର ବି ପରୀତ କୋଣ ସର୍ବ ବୃ ହତ ଅଟେ ।
(d) ସମସ୍ତ ଅନ୍ତଃସ୍ତ କୋଣ ସୂ କ୍ଷ୍ମ କୋଣ ହୋଇପାରି ବ ନାହିଁ ।

A.  B. (a)

B.  A. (b)

C.  C. (c)

D.  D. (d)

✓

Q11 Quant
28 cm ବାହୁ  ବି ଶି ଷ୍ଟ ଏକ ସମଘନର ସମଗ୍ର  ପୃ ଷ୍ଠତଳର କ୍ଷେତ୍ର ଫଳ କେତେ?

A.  D. 4704 cm2

B.  A. 4664 cm2

C.  B. 4780 cm2

D.  C. 4610 cm2

✓

Q12 Quant
A number is first decreased by 25% and then increased by 20%. The
number so obtained is 356 less than then the original number. What
is 40% of the original number?

A.  A. 1244

B.  C. 1224

C.  B. 1424

D.  D. 1422

✓

Q13 Quant
The price of a stock decreased by 8% one week and increased by
20% in the following week. If the initial price of the stock was
₹48,000, find the final price of the stock after these two weeks.

A.  D. ₹52,792

B.  B. ₹52,992

C.  A. ₹52,469

D.  C. ₹52,575

✓

Q14 Quant
ଜଣେ ଡି ଲର ୱାସିଂ  ମେସି ନ୍  ପି ଛା ₹87000 ହାରରେ ଦୁ ଇଟି  ୱାସିଂ  ମେସି ନ୍  ବି କ୍ରି   କରନ୍ତି  ।
ଗୋଟି ଏରେ ସେ 20% ଲାଭ ଅର୍ଜ ନ କରନ୍ତି  ଏବଂ ଅନ୍ୟଟି ରେ ସେ 40% କ୍ଷତି  ସହନ୍ତି  । ସମଗ୍ର
କାରବାରରେ ତାଙ୍କର କ୍ଷତି  ପ୍ର ତି ଶତ କେତେ?

A.  D. 20%

B.  C. 19%

C.  B. 22%

D.  A. 18%

✓

Q15 Quant
A person travels 60 km by car at a speed of 40 km/h and then covers
the next 40 km by bus at a speed of 60 km/h. What is the average
speed (rounded off to two decimal places) of the person for the
entire trip?

A.  D. 46.15 km/h

B.  C. 49.25 km/h

C.  A. 41.52 km/h

D.  B. 44.53 km/h

✓

Q16 Quant
A can complete a piece of work in 72 hours; B and C together can
complete it in 48 hours, while A and C together can complete it in 36
hours. How long (in hours) will B alone take to complete the work?

A.  A. 144

B.  C. 143

C.  B. 145

D.  D. 146

✓

Q17 Quant
3 ର ପ୍ର ଥମ 17 ଟି  ଗୁ ଣି ତକର ହାରାହାରି  କେତେ?

A.  D. 27

B.  B. 3

C.  C. 17

D.  A. 25.5
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✓

Q18 Quant

Find the roots of the quadratic equation 2x2 + 5x + 3 = 0.

A.  

B.  

C.  

D.  

✓

Q19 Quant
A solid cone has a radius of 21 cm. The slant height of the cone is 28 cm. The cone is hollowed out such that the hollow part is a smaller cone
similar to the original cone with its radius half of the original radius. Find the curved surface area of the remaining solid.

A.  

B.  

C.  

D.  

✓

Q20 Quant

A.  B. 70.345

B.  D. 71.865

C.  C. 72.752

D.  A. 73.644

GA

✓

Q21 GA
ଭାରତରେ ଗୋରୁ ମହି ସାଣି  ଲୁ ହାପଥର ଖଣି  କେଉଁ ଠାରେ ଅବସ୍ଥି ତ?

A.  C. କେନ୍ଦୁ ଝର ଜି ଲ୍ଲା, ଓଡି ଶା 

B.  A. ସୁ ନ୍ଦରଗଡ ଜି ଲ୍ଲା, ଓଡ଼ି ଶା

C.  D. ମୟୂ ରଭଞ୍ଜ ଜି ଲ୍ଲା, ଓଡ଼ି ଶା

D.  B. କୋରାପୁ ଟ ଜି ଲ୍ଲା, ଓଡ଼ି ଶା

✓

Q22 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ଜାତୀୟ ନେତା 1857 ମସି ହାର ବି ଦ୍ରୋ ହକୁ  ପ୍ର ସି ଦ୍ଧ ଭାବରେ 'ଭାରତୀୟ
ସ୍ୱାଧୀନତାର ପ୍ର ଥମ ଯୁ ଦ୍ଧ' ବୋଲି  ବର୍ଣ୍ଣ ନା କରି ଥି ଲେ?

A.  A. ବାଲ ଗଙ୍ଗାଧର ତି ଲକ

B.  B. ଭି . ଡି . ସାବରକର

C.  D. ସୁ ଭାଷ ଚନ୍ଦ୍ର ବୋଷ

D.  C. ମହାତ୍ମା ଗାନ୍ଧୀ

✓

Q23 GA
2025 ମସି ହା ମାର୍ଚ୍ଚ  ମାସରେ ଓଡ଼ି ଶାରେ ସମାଜ ପ୍ର ତି  ଅବଦାନ ପାଇଁ  ବଂଶୀଧର ଏବଂ ଇଲା
ପଣ୍ଡା ଫାଉଣ୍ଡେସନ ଦ୍ୱାରା ପ୍ର ତି ଷ୍ଠି ତ 12 ତମ 'ଶାମ୍ଭବୀ ପୁ ରସ୍କାର' ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି
ଜି ତି ଛନ୍ତି ?

A.  D. ସମନ୍ୱି  ତ ଗ୍ରା ମୀଣ ଏବଂ ଆଦି ବାସୀ ବି କାଶ କେନ୍ଦ୍ର

B.  B. ଗ୍ରା ମୀଣ ପୁ ନର୍ଗ ଠନ ଏବଂ ସାମାଜି କ ସେବା ଅନୁ ଷ୍ଠାନ

C.  C. ପ୍ରା କୃ ତି କ ସମାଜ କଲ୍ୟାଣ ପ୍ର ତି ଷ୍ଠାନ

D.  A. ଲଘୁ ସଂଖ୍ୟାକ ଅଭି ଗମ୍ୟତା ଗବେଷଣା ସମି ତି
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✓

Q24 GA
20ତମ ଶତାବ୍ଦୀର ପ୍ରା ରମ୍ଭରେ କେଉଁ  ଅନୁ ଷ୍ଠାନକୁ  ଓଡ଼ି ଆ ଭାଷାଗତ ଏବଂ ସାଂସ୍କୃତି କ
ଏକୀକରଣ ଆନ୍ଦୋଳନର ନେତୃ ତ୍ୱ ନେବାର ଶ୍ରେ ୟ ଦି ଆଯାଏ, ଯାହା ପରି ଶେଷରେ 1936
ମସି ହାରେ ଏକ ସ୍ୱତନ୍ତ୍ର ଓଡ଼ି ଶା ପ୍ର ଦେଶ ଗଠନରେ ବି ଶେଷ ସହାୟକ ହୋଇଥି ଲା?

A.  A. ସର୍ଭା ଣ୍ଟସ ଅଫ ଇଣ୍ଡି ଆ ସୋସାଇଟି  

B.  D. ଉତ୍କଳ ସମ୍ମି ଳନୀ

C.  B. ଆର୍ଯ୍ୟ  ସମାଜ, କଟକ ଶାଖା

D.  C. ଇଣ୍ଡି ଆନ୍  ନ୍ୟାସନାଲ ସୋସି ଆଲ କନଫରେନ୍ସ

✓

Q25 GA
ସାମାଜି କ ଏବଂ ଆର୍ଥିକ ନ୍ୟାୟ ସମେତ ଏକ କଲ୍ୟାଣକାରୀ ରାଷ୍ଟ୍ର ଗଠନରେ ସରକାରଙ୍କୁ
ମାର୍ଗ ଦର୍ଶ ନ କରୁ ଥି ବା ରାଷ୍ଟ୍ର ନି ର୍ଦ୍ଦେ ଶକ ନୀତି ଗୁ ଡ଼ି କ ଭାରତୀୟ ସମ୍ବି ଧାନର କେଉଁ  ଭାଗରେ
ଅଛି ?

A.  B. ଭାଗ II

B.  A. ଭାଗ IV

C.  C. ଭାଗ VII

D.  D. ଭାଗ IX

✓

Q26 GA
ସେପ୍ଟେମ୍ବର 2025 ରେ ପ୍ର କାଶି ତ ରି ପୋର୍ଟ  ଅନୁ ଯାୟୀ ପ୍ର ତି ଷ୍ଠା କ୍ର ମ ଦୃ ଷ୍ଟି ରୁ  ଦେବ୍ରି  ଗଡ଼
ବନ୍ୟଜନ୍ତୁ ଅଭୟାରଣ୍ୟ ଓଡ଼ି ଶାର କେତେ ନମ୍ବର ଜାତୀୟ ଉଦ୍ୟାନ ଭାବରେ ପରି ଣତ ହେବା
ପାଇଁ  ପ୍ର ସ୍ତାବ ଦି ଆଯାଇଥି ଲା?

A.  D. ପ୍ର ଥମ

B.  A. ଦ୍ୱି ତୀୟ

C.  B. ତୃ ତୀୟ

D.  C. ଚତୁ ର୍ଥ

✓

Q27 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଭାରତର ଯେକୌଣସି  ଗ୍ରା ମୀଣ ପରି ବାରକୁ , ଯାହାଙ୍କର ବୟସ୍କ
ସଦସ୍ୟମାନେ ଅଣକୁ ଶଳୀ ଶାରୀରି କ ଶ୍ର ମ କରି ବାକୁ  ସ୍ଵେଚ୍ଛାକୃ ତ ଭାବେ ଆଗ୍ର ହୀ, ଗୋଟି ଏ
ଆର୍ଥିକ ବର୍ଷ ରେ 100 ଦି ନର ରୋଜଗାର ସୁ ନି ଶ୍ଚି ତ କରି ବାର ଗ୍ୟାରେଣ୍ଟି  ପ୍ର ଦାନ କରି ଥାଏ?

A.  C. ମହାତ୍ମା ଗାନ୍ଧୀ ଜାତୀୟ ଗ୍ରା ମୀଣ ରୋଜଗାର ଗ୍ୟାରେଣ୍ଟି  ଅଧି ନି ୟମ

B.  A. ଦୀନଦୟାଲ ଅନ୍ତୋଦୟ ଯୋଜନା – ଜାତୀୟ ଗ୍ରା ମୀଣ ଜୀବି କା ମି ଶନ

C.  D. ଶ୍ର ମ କଲ୍ୟାଣ ପାଣ୍ଠି  ଅଧି ନି ୟମ, 1965

D.  B. ଭାରତରେ ପଞ୍ଚାୟତି ରାଜର 73 ତମ ସଂଶୋଧନ

✓

Q28 GA
ନଭେମ୍ବର 2025 ରେ ଘୋଷଣା ଅନୁ ଯାୟୀ ନୂ ତନ ଶ୍ର ମ ସଂହି ତା କାର୍ଯ୍ୟ କ୍ଷେତ୍ର ରେ
ମହି ଳାମାନଙ୍କୁ  କେଉଁ  ପ୍ର ମୁ ଖ ସୁ ବି ଧା ପ୍ର ଦାନ କରୁ ଅଛି ?

A.  A. ବ୍ୟକ୍ତି ଗତ କାରଣରୁ  ଅସୀମି ତ ଛୁ ଟି  

B.  D. 60 ବର୍ଷ  ବୟସ ପରେ ଅବସରକାଳୀନ ସୁ ବି ଧା 

C.  C. 26 ସପ୍ତାହ ପର୍ଯ୍ୟ ନ୍ତ ପ୍ର ସୂ ତି  ଛୁ ଟି  

D.  B. ବାଧ୍ୟତାମୂ ଳକ ବି ଦେଶୀ ତାଲି ମ ସୁ ଯୋଗ 

✓

Q29 GA
2025 ମସି ହାରେ କେଉଁ  ରାଷ୍ଟ୍ର ବି ଲି  ଜି ନ କି ଙ୍ଗ କପ ଟାଇଟଲ ହାସଲ କରି ଥି ଲା?

A.  C. ଯୁ କ୍ତରାଷ୍ଟ୍ର ଆମେରି କା

B.  B. ଚେକ୍  ଗଣରାଜ୍ୟ 

C.  D. ଅଷ୍ଟ୍ରେଲି ଆ

D.  A. ଇଟାଲୀ

✓

Q30 GA
Which Indian shooter won a gold medal in the women’s 10 m air
pistol event at ISSF World Cup Rifle/Pistol 2025 held in Ningbo
during 7th to 15th September 2025?

A.  C. Esha Singh

B.  D. Manu Bhaker

C.  A. Elavenil Valarivan

D.  B. Suruchi Singh

✓

Q31 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ବି ବୃ ତି ଟି  ଉତ୍ତର-ପଶ୍ଚି ମ ଭାରତର ପ୍ରା କୃ ତି କ ଭୂ ଗୋଳ ଉପରେ ଆରାବଳୀ
ପର୍ବ ତମାଳାର ପ୍ର ଭାବକୁ  ସର୍ବା ଧି କ ସ୍ପଷ୍ଟ ଭାବରେ ବର୍ଣ୍ଣ ନା କରେ?

A.  B. ସେଗୁ ଡି କ ମୌସୁ ମୀ ବାୟୁ କୁ  ଅବରୋଧ କରି  ରାଜସ୍ଥାନରେ ପ୍ର ବଳ ବୃ ଷ୍ଟି ପାତ
ସୃ ଷ୍ଟି  କରନ୍ତି  ।

B.  C. ସେଗୁ ଡ଼ି କ ଥର ମରୁ ଭୂ ମି ର ପୂ ର୍ବା ଭି ମୁ ଖୀ ପ୍ର ସାରଣକୁ  ରୋକି ବା ପାଇଁ  ଏକ
ପ୍ର ତି ବନ୍ଧକ ଭାବରେ କାର୍ଯ୍ୟ  କରନ୍ତି  । 

C.  A. ସେଗୁ ଡି କ ଦାକ୍ଷି ଣାତ୍ୟ ମାଳଭୂ ମି କୁ  ଦୁ ଇ ଭାଗରେ ବି ଭକ୍ତ କରନ୍ତି  ।

D.  D. ସେଗୁ ଡି କ ଭାରତ ଏବଂ ମଧ୍ୟ ଏସି ଆ ମଧ୍ୟରେ ସୀମାରେଖା ନି ର୍ଦ୍ଧା ରଣ କରନ୍ତି  ।

✓

Q32 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଚତୁ ର୍ବେ ଦରେ ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ ?

A.  B. ଉପନି ଷଦ

B.  D. ଆରଣ୍ୟକ

C.  C. ବ୍ରା ହ୍ମଣ

D.  A. ନେତ୍ତି ପକରଣ

✓

Q33 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏକ ପରି ସଂସ୍ଥାରେ ଜୈ ବି କ ପାରସ୍ପରି କ କ୍ରି  ୟା (biotic
interaction) ର ଏକ ଉଦାହରଣ ଅଟେ?

A.  B. ଜଳରେ ଦ୍ର ବୀଭୂ ତ ହେଉଥି ବା ଖଣି ଜ ପଦାର୍ଥ

B.  C. ପ୍ରା ଣୀମାନଙ୍କ ମଧ୍ୟରେ ଶି କାର କରି ବା ପ୍ର ବୃ ତ୍ତି

C.  D. ଉଦ୍ଭି ଦ ବୃ ଦ୍ଧି କୁ  ପ୍ର ଭାବି ତ କରୁ ଥି ବା ବାୟୁ

D.  A. ସୂ ର୍ଯ୍ୟା ଲୋକ ଦ୍ଵାରା ମୃ ତ୍ତି କା ଉତ୍ତପ୍ତ ହେବା
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✓

Q34 GA
ନି ମ୍ନ ଲି ଖି ତ ଧର୍ମ ଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ  ଧର୍ମ  ମହାବୀରଙ୍କ ଉପଦେଶରେ ବି ଶ୍ୱାସ କରେ?

A.  C. ବୌଦ୍ଧ ଧର୍ମ

B.  A. ଇସଲାମ ଧର୍ମ

C.  D. ଜୈ ନ ଧର୍ମ

D.  B. ଶି ଖ ଧର୍ମ

✓

Q35 GA
ଭାରତରେ ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  କାର୍ଯ୍ୟ କ୍ର ମ ସ୍ଥାୟୀ ବି କାଶର ଲକ୍ଷ୍ୟ ସହି ତ ସର୍ବା ଧି କ ସମ୍ବନ୍ଧି ତ
ଅଟେ?

A.  A. ବର୍ଦ୍ଧିତ ଚାହି ଦା ମେଣ୍ଟାଇବା ପାଇଁ  କୋଇଲା ଭି ତ୍ତି କ ଶକ୍ତି ର ସମ୍ପ୍ରସାରଣ

B.  C. କୃ ଷି ଜାତ ଉତ୍ପାଦକତା ପାଇଁ  ଭୂ ତଳ ଜଳର ଅତ୍ୟଧି କ ନି ଷ୍କାସନ

C.  D. ମୁ ଖ୍ୟତଃ ଆର୍ଥିକ ଦକ୍ଷତା ନି ମନ୍ତେ ଇନ୍ଧନ ସବସି ଡି ର ସମ୍ପ୍ରସାରଣ

D.  B. ପ୍ର ଦୂ ଷଣ ହ୍ରା ସ ପାଇଁ  ଜାତୀୟ ସ୍ୱଚ୍ଛ ବାୟୁ  କାର୍ଯ୍ୟ କ୍ର ମ

✓

Q36 GA
ଧାତୁ  ନି ଷ୍କାସନରେ ଧାତୁ  ପି ଣ୍ଡର ସମୃ ଦ୍ଧି ର ଉଦ୍ଦେଶ୍ୟ କ'ଣ?

A.  C. ଧାତୁ ପି ଣ୍ଡକୁ  ଧାତୁ ରେ ରୂ ପାନ୍ତରି ତ କରି ବା 

B.  B. ରାସାୟନି କ ପଦ୍ଧତି ରେ ଧାତୁ ର ପରି ମାଣ ବୃ ଦ୍ଧି  କରି ବା

C.  A. ଧାତୁ ର ରାସାୟନି କ ପ୍ର କୃ ତି  ପରି ବର୍ତ୍ତ ନ କରି ବା 

D.  D. ଧାତୁ ପି ଣ୍ଡରୁ  ଅଶୁ ଦ୍ଧତା ଦୂ ର କରି ବା 

✓

Q37 GA
ପୃ ଥି ବୀ ପୃ ଷ୍ଠ ନି କଟରେ ମୁ କ୍ତ ପତନ ସମୟରେ (ବାୟୁ  ପ୍ର ତି ରୋଧକୁ  ଅଣଦେଖା କଲେ), ଏକ
ବସ୍ତୁର ତ୍ୱରଣର ପ୍ର କୃ ତି  କ'ଣ ହେବ?

A.  C. ଶୂ ନ 

B.  A. ପରି ବର୍ତ୍ତ ନଶୀଳ

C.  D. ସ୍ଥି ର ଏବଂ ମାଧ୍ୟାକର୍ଷ ଣଜନି ତ ତ୍ୱରଣ ସହି ତ ସମାନ 

D.  B. ବସ୍ତୁତ୍ୱ ଉପରେ ନି ର୍ଭ ର କରେ

✓

Q38 GA
ପାଶ୍ଚାତ୍ୟ ସଙ୍ଗୀତ ବାଦ୍ୟଯନ୍ତ୍ର ବର୍ଗୀ କରଣ ପଦ୍ଧତି  କେଉଁ  ପ୍ରା ଚୀନ ଭାରତୀୟ ପଦ୍ଧତି ରୁ  ଗୃ ହୀତ
ହୋଇଛି ?

A.  B. ବୈ ଦି କ ସଂହି ତା ବର୍ଗୀ କରଣ

B.  D. ଅର୍ଥ ଶାସ୍ତ୍ର ବର୍ଗୀ କରଣ

C.  C. ନାଟ୍ୟ ଶାସ୍ତ୍ର ବର୍ଗୀ କରଣ

D.  A. ସଙ୍ଗୀତ ରତ୍ନାକର ବର୍ଗୀ କରଣ

✓

Q39 GA
କ୍ରା ନ୍ତୀୟ ଅଞ୍ଚଳରେ କେଉଁ  କାରକଟି  ରାସାୟନି କ ଚୂ ର୍ଣ୍ଣୀ ଭବନକୁ  ସର୍ବା ଧି କ ତ୍ୱରାନ୍ୱି  ତ କରି ଥାଏ?

A.  B. ଉଚ୍ଚ ତାପମାତ୍ରା  ଏବଂ ଅତ୍ୟଧି କ ବୃ ଷ୍ଟି ପାତ

B.  D. ଶକ୍ତି ଶାଳୀ ବାୟୁ  ସ୍ରୋ ତ ଏବଂ ଶୁ ଷ୍କ ଜଳବାୟୁ  

C.  C. ନି ମ୍ନ  ତାପମାତ୍ରା  ଏବଂ ବି ରଳ ଉଦ୍ଭି ଦସମୂ ହ

D.  A. ତୀକ୍ଷଣ ଢାଲୁ  ଏବଂ ଦ୍ରୁ ତ ନଦୀ ପ୍ର ବାହ 

✓

Q40 GA
ନି ମ୍ନ ଲି ଖି ତ ଯୋଜନାଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି କୁ  PM VIKAS ପଦକ୍ଷେପରେ ମି ଶା
ଯାଇନଥି ଲା?

A.  B. ସୀଖୋ ଔର କମାଓ

B.  D. ନଇ ମଞ୍ଜି ଲ

C.  A. ନଇ ରୋଶନି

D.  C. ନଇ ଦର୍ଶ ନ
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English

✓

Q41 English
Select the option that can be used as a one-word substitute for the underlined group of words.

My father enquired about a(an) consultant for eye diseases.

A.  B. altruist

B.  C. scrounger

C.  A. oculist

D.  D. convalescent

✓

Q42 English
Choose the option that is the correct opposite of the underlined word.

The group of boys, quietly and without being noticed, plundered the houses in the village.

A.  A. ignored

B.  C. touched

C.  D. protected

D.  B. observed

✓

Q43 English
Identify the antonym of the highlighted word.
I am pondering whether or not I should join another committee.

A.  A. Contemplating

B.  C. Overlooking

C.  B. Reviewing

D.  D. Considering

✓

Q44 English
Complete the sentence by choosing the correct option.

When I met Rina last night, she .................. her assignment.

A.  C. worked on

B.  B. was working on

C.  A. had worked on

D.  D. had been working on

✓

Q45 English
Identify the correct sentence which is correctly written in direct speech.

A.  A. He said that, “I am tired.”

B.  B. He said, “I am tired.”

C.  D. He said that he is tired.

D.  C. He said to me that, “I am tired.”
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✓

Q46 English
Choose the correct meaning of the underlined idiom.

I have not mentioned any names yet, but if the cap fits, you should wear it.

A.  C. If you try hard, success will follow

B.  A. If you lose something, replace it soon

C.  B. If you like something, take it quickly

D.  D. If the remark applies to you, accept it

✓

Q47 English
Select the correct proverb that can substitute the underlined group of words in the given sentence.

After hearing the rumors, the principal warned students that (what you throw comes back to you).

A.  A. a bird in the hand is worth two in the bush

B.  B. as you sow, so shall you reap

C.  D. every cloud has a silver lining

D.  C. the last straw

✓

Q48 English
From the options given below, choose the sentence which is correctly written in active voice.

A.  B. The scientist discovered a new element last year.

B.  C. The scientist discovers a new element last year.

C.  A. The scientist discover a new element last year.

D.  D. The scientist discovering a new element last year.

✓

Q49 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

(A) along with his college friends,/ (B) and their tents got flooded/ (C) ended early/ (D) Ronan's camping trip,/ (E) as there was a thunderstorm

A.  C. BDACE

B.  B. DACEB

C.  D. DECBA

D.  A. ACEDB

✓

Q50 English
Select the most appropriate option from the given alternatives to fill in the blank.
The cat jumped _____ the wall and disappeared into the bushes.

A.  A. for

B.  D. over

C.  B. in

D.  C. at
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✓

Q51 English

Read the following passage carefully and answer the questions that follow.
In India, energy comes from both renewable and non-renewable sources. Non-renewable sources such as coal, oil, and natural gas are widely
used but cause pollution and may run out in the future. Renewable sources like solar, wind, hydro, and biomass are cleaner and can be used for a
long time without being exhausted. India is working to increase the use of renewable energy to reduce pollution and protect the environment.
Solar and wind energy are growing rapidly due to government support and improved technology. Energy efficiency is also important, as it helps
reduce waste and save resources. The country is focusing on cleaner energy solutions such as electric vehicles and better power systems. These
steps can reduce carbon emissions and improve air quality. By using more renewable energy and improving efficiency, India aims to build a
sustainable future. Responsible use of energy by individuals and industries is also necessary to ensure long-term energy security and
environmental protection.

Which option gives the most complete summary?

A.  B. Energy use should increase without limits

B.  A. Clean energy and efficiency ensure a better future

C.  C. Only traditional fuels are important today

D.  D. Pollution is not linked to energy use

✓

Q52 English
Which energy source is renewable?

A.  B. Coal used in power plants

B.  A. Oil used in vehicles

C.  C. Natural gas from the earth

D.  D. Solar energy from sunlight

✓

Q53 English
What does “renewable” mean in the passage?

A.  B. Can be used again and again

B.  A. Cannot be replaced once used

C.  D. Found only in limited areas

D.  C. Used only in industries

✓

Q54 English
What theme does the passage give?

A.  B. Use only non-renewable sources

B.  A. Shift towards cleaner energy sources

C.  C. Stop using energy in daily life

D.  D. Depend only on traditional fuels

✓

Q55 English
What can be inferred about renewable energy?

A.  D. It is harmful to the environment

B.  C. It is limited and will finish soon

C.  B. It is cleaner and more sustainable

D.  A. It is more expensive in all cases
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✓

Q56 English
Fill in the blank with the most appropriate option.

He _______ the truth after much hesitation.

A.  D. confessed

B.  C. concealed

C.  B. said

D.  A. informed

✓

Q57 English
Rearrange the segments (labelled P, Q, R, S) by choosing the correct option to form a coherent and meaningful sentence.

P. each other understand difficult parts, and completed
Q. after the teacher explained the concept clearly in class,
R. their assignment on time with confidence and accuracy
S. the students practised the questions together, helped

A.  D. PRSQ

B.  C. QSPR

C.  B. QPSR

D.  A. SPQR

✓

Q58 English
Select the most appropriate option to fill in the blanks. If no article is required, select the option with ‘X’.

Please take ____ water bottle with you. It is _____ too hot and you might get ____ dehydrated.

A.  B. a; X; X

B.  C. X; a; X

C.  A. an; a; a

D.  D. X; X; a
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✓

Q59 English
Select the option that can be used as a one-word substitute for the underlined group of words.

She was showing deep religious feeling and is committed to helping the poor and the needy.

A.  A. devout

B.  C. apathetic

C.  D. sceptical

D.  B. indifferent

✓

Q60 English
Rectify the sentence by selecting the correct spelling from the options.
Experience has shown that human resource is the most valuable asset of any business. It is more valuable than capital or equipment.
Unfortunately, it is also the most wasted. People can be your biggest asset or your biggest liabilty.

A.  C. Liability

B.  A. Resourcs

C.  B. Equpment

D.  D. Aset

Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ବି ପରୀତ ଶବ୍ଦ ଲେଖନ୍ତୁ
ସେ ଏକ "ଧନୀ" ବ୍ୟବସାୟୀ।

A.  A. ଗରି ବ

B.  B. ଭଲ

C.  D. ସୁ ନ୍ଦର

D.  C. ଶକ୍ତି ଶାଳୀ

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ସେ ଘରୁ  ବାହାରି ବା ଆଗରୁ  ଜଳପାନ ଗ୍ର ହଣ କରନ୍ତି  ।

A.  A. He takes breakfast before leaving home.

B.  C. He take breakfast before leave home.

C.  B. He taken breakfast before leaving house.

D.  D. He taking breakfast before to go.
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✓

Q63 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ରୋଜି  ତା ସ୍କୁଲ ରେ ଅଲ ରାଉଣ୍ଡର ପୁ ରସ୍କାର ପାଇଲା ।

A.  C. Rosy won the all-rounder award in her school.

B.  B. Rosy will win the all-rounder award in her school.

C.  A. Rosy is the all-rounder in her school.

D.  D. Rosy was the winner of the all-rounder award in her school.

✓

Q64 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ଲତା ମଙ୍ଗେସ୍କରଙ୍କ ସୁ ମଧୁ ର କଣ୍ଠସ୍ଵର ର ଭଜନ ସମସ୍ତଙ୍କୁ  ମନ୍ତ୍ରମୁ ଗ୍ଧ କରି ଦି ଏ ।

A.  C. The melodious Bhajans of Lata Mangeshkar's voice enchant everyone.

B.  B. Lata Mangeshkar's melodious voice of Bhajans were very beautiful .

C.  A. Lata Mangeshkar's Bhajans are very soothing .

D.  D. Lata Mangeshkar's melodious voice enchants everyone.

✓

Q65 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦକୁ  ପାଠ କରି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ବାଛ ।
କୁ ହାଯାଏ "ନଈ କେ ବାଙ୍କ,ଦେଶ କେ ଫାଙ୍କ" । ସାଧାରଣତଃ ମୃ ତ୍ତି କାର କୋମଳ ଅଂଶ ଦେଇ ନଈ ଧାର
ଆଗେଇ ଚାଲେ । ଯେଉଁ  ପାର୍ଶ୍ଵ ରେ ମାଟି  ଯେତେ କୋହଳ ତାହା ସେହି  ଆଡ଼କୁ  ସେତେ ମୁ ହାଁ ଇ ଯାଏ । ତେଣୁ
ସେହି  ଆଡ଼କୁ  ବଙ୍କାହୋଇ ଆଗକୁ  ଯାଏ। ଏହି  କ୍ର ମରେ ପ୍ର ତ୍ୟେକ ନଦୀର ଗତି ପଥ ବକ୍ର  ହୋଇଥାଏ । ଅନ୍ୟ
ପକ୍ଷରେ 'ଫାଙ୍କ'ର ଅର୍ଥ  ହେଉଛି  ବି ଭି ନ୍ନ ରୀତି  ବା ବି ଶେଷ ରୀତି  । ତେଣୁ  ଦେଶକେ ଫାଙ୍କ'ର ଅର୍ଥ  - ପ୍ର ତ୍ୟେକ
ଦେଶର ଚଳଣି  ରୀତି  ହେଉଛି  ସ୍ଵତନ୍ତ୍ର । ତାହା ଅନ୍ୟ ଦେଶର ଚଳଣି  ଠାରୁ  ଭି ନ୍ନ । ଯେପରି କି  ; ଇଂଲଣ୍ଡରେ ବାସ
କରୁ ଥି ବା ଲୋକେ ଇଂରାଜୀକୁ  ରାଷ୍ଟ୍ରଭାଷା ରୂ ପେ ଗ୍ର ହଣ କଲାବେଳେ ପାକି ସ୍ଥାନର ଲୋକେ ଉର୍ଦ୍ଦୁ ଭାଷାକୁ
ନି ଜର କରି  ନେଇଛନ୍ତି  । ସେହି ପରି  ଆମ ଭାରତରେ ବି ବି ଧ ଭାଷା ପ୍ର ଚଳି ତ ଥି ବା ସତ୍ତ୍ୱେ 'ହି ନ୍ଦୀ' ରାଷ୍ଟ୍ରଭାଷାର
ମାନ୍ୟତା ଲାଭ କରି ଛି  । ଖାଦ୍ୟ, ପାନୀୟ ତଥା ପୋଷାକ ଓ ପର୍ବ ପର୍ବା ଣି  ପାଳନରେ ମଧ୍ୟ ତାରତମ୍ୟ ରହି ଛି  ।
ଏଥି ରୁ  ଜଣାଯାଏ, ମନୁ ଷ୍ୟରୁ  ମନୁ ଷ୍ୟ ଓ ଦେଶରୁ  ଦେଶ ମଧ୍ୟରେ ଚଳଣି  ତଥା ରୀତି ନୀତି ର ଭି ନ୍ନତା ନି ଶ୍ଚି ତ
ଭାବରେ ରହି ବ ହିଁ ରହି ବ। କି ନ୍ତୁ ସମ୍ପର୍କ  ସ୍ଥାପନ କରି ବାକୁ  ହେଲେ ତାଙ୍କ ରୀତି ନୀତି  ତଥା ପରି ସ୍ଥି ତି  ପ୍ର ତି
ଅସୂ ୟା ଭାବ ପୋଷଣ ନକରି  ନି ଜକୁ  ସାମି ଲ କରି ନେବା ହେଉଛି  ବୁ ଦ୍ଧି ମାନର କାମ ।

"ଫାଙ୍କ" ଶବ୍ଦର ଅର୍ଥ  କଣ ?

A.  A. ଖାଲି  ସ୍ଥାନ

B.  D. ବି ଭି ନ୍ନ ରୀତି  ବା ବି ଶେଷ ରୀତି

C.  C. ଏକମାତ୍ର  ପଦ୍ଧତି

D.  B. ଅନୁ ଶାସନ
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✓

Q66 Odia
ଅନ୍ୟ ଦେଶ ସହ ସମ୍ପର୍କ  ସ୍ଥାପନ ପାଇଁ  କଣ କରି ବା ଉଚି ତ ?

A.  D. ନି ଜ ରୀତି କୁ  ଜୋର କରି ବା

B.  B. ଅସୁ ୟା ଭାବ ପୋଷଣ କରି ବା

C.  C. ତାଙ୍କ ରୀତି ନୀତି କୁ  ଅସ୍ଵୀକାର କରି ବା

D.  A. ତାଙ୍କ ରୀତି ନୀତି କୁ  ସ୍ଵୀକାର କରି  ନି ଜକୁ  ସାମି ଲ କରି ବା

✓

Q67 Odia
ଭାରତ ବର୍ଷ ରେ କେଉଁ  ଭାଷା ରାଷ୍ଟ୍ରଭାଷାର ମାନ୍ୟତା ଲାଭ କରି ଛି  ବୋଲି  ଉଲ୍ଲେଖ ଅଛି  ?

A.  B. ଓଡି ଆ

B.  D. ଇଂରାଜୀ

C.  C. ଉର୍ଦ୍ଦୁ

D.  A. ହି ନ୍ଦୀ

✓

Q68 Odia
ଅନୁ ଚ୍ଛେଦ ଅନୁ ସାରେ ପ୍ର ତ୍ୟେକ ଦେଶର ଚଳଣି  କି ପରି  ?

A.  B. ସମାନ

B.  A. ଅସ୍ଥାୟୀ

C.  D. ସ୍ଵତନ୍ତ୍ର ଓ ଭି ନ୍ନ

D.  C. ଅନି ୟମି ତ

✓

Q69 Odia
ନଦୀର ଗତି ପଥ ବକ୍ର (ଅଙ୍କାବଙ୍କା) ହେବାର ପ୍ର ମୁ ଖ କାରଣ କଣ ?

A.  B. ପାଣି ର ଅଭାବ

B.  C. ପାହାଡର ଉପସ୍ଥି ତି

C.  A. ମୃ ତ୍ତି କାର କୋମଳତାର ଭି ନ୍ନତା

D.  D. ବାୟୁ ର ଚାପ

✓

Q70 Odia
କାଲି  ମୋତେ ଜ୍ଵର ହୋଇଥି ଲା , ତେଣୁ  ମୁଁ  ସ୍କୁଲକୁ  ଯାଇ ନ ଥି ଲି  ।ଏଥି ରେ ଥି ବା ଅବ୍ୟୟ ପଦଟି କୁ  ଚି ହ୍ନଟ କର ।

A.  A. ମୋତେ

B.  D. ହୋଇଥି ଲା

C.  C. ସ୍କୁଲକୁ

D.  B. ତେଣୁ

✓

Q71 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏକ 'ତଦ୍ଭବ' ଶବ୍ଦର ଉଦାହରଣ?

A.  B. ଆକାଶ

B.  D. ପର୍ବ ତ

C.  A. ନଦୀ

D.  C. ଘି ଅ
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✓

Q72 Odia
ନି ମ୍ନୋ କ୍ତ ବାକ୍ୟଗୁ ଡି କ ମଧ୍ୟରୁ  ଶୁ ଦ୍ଧ ବାକ୍ୟଟି କୁ  ଚି ହ୍ନଟ କର।

A.  C. ଜନସେବକମାନେ ବନା ସମୟରେ ସାହସର ଡଙ୍ଗାରେ ସହି ତ ଯାଇ ଗାଁ ’ ଗଣ୍ଡାରେ ଚୁ ଡ଼ାଚାଉଳ ବାଣ୍ଟନ୍ତି  ।

B.  A. ସାହସର ଜନସେବକମାନେ ବନ୍ୟା ସମୟରେ ସହି ତ ଡଙ୍ଗାରେ ଯାଇ ଗାଁ ’ ଗଣ୍ଢାରେ ଚୁ ଡ଼ାଚାଉଳ ବାଣ୍ଟନ୍ତି  ।

C.  D. ଜନସେବକମାନେ ବନ୍ୟା ସମୟରେ ସାହସର ସହି ତ ଡଙ୍ଗାରେ ଯାଇ ଗାଁ ’ ଗଣ୍ଡାରେ ଚୁ ଡ଼ାଚାଉଳ ବାଣ୍ଟନ୍ତି  ।

D.  B. ଜନସେବକମାନେ ବନ୍ୟା ଡଙ୍ଗାରେ ସମୟରେ ସାହସର ଚୂ ଡ଼ାଚାଉଳ ସହି ତ ଯାଇ ଗାଁ ’ ଗଣ୍ଡାରେ ବାଣ୍ଟନ୍ତି  ।

✓

Q73 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସମ୍ବୋଧନ ସୂ ଚକ ଅବ୍ୟୟ ନୁ ହେଁ  ।

A.  A. ହେ

B.  D. ଆରେ

C.  B. ଗୋ

D.  C. ଏବେ

✓

Q74 Odia
ଦୀପ ମି ଞ୍ଜି ମି ଞ୍ଜି  ଜଳୁ ଛି  ।- ରେଖାଙ୍କି ତ ପଦଟି  କେଉଁ  ପ୍ର କାର କ୍ରି  ୟା ବି ଶେଷଣ?

A.  B. ବି ଧେୟ ବି ଶେଷଣ

B.  C. କ୍ରି  ୟା ବି ଶେଷଣ

C.  D. ବି ଶେଷଣର ବି ଶେଷଣ

D.  A. ଅବସ୍ଥାବାଚକ ବି ଶେଷଣ

✓

Q75 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  C. ଆଚାର

B.  B. ଆଲମାରି

C.  A. କୋବି

D.  D. କୁ ଆଁ ରୀ
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Computer

✓

Q76 Computer
Which feature in MS Word helps to find a specific word or phrase
within a document?

A.  C. Review

B.  D. Find and Replace

C.  A. Word Count

D.  B. Spell Check

✓

Q77 Computer
ଆପ୍ଲି  କେସନଗୁ ଡି କୁ  ରନ କରି ବା ଏବଂ ମ୍ୟାନେଜ କରି ବା ପାଇଁ  ଦାୟୀ ସଫ୍ଟ ୱେରକୁ
___________ କୁ ହାଯାଏ ।

A.  C. ସି ଷ୍ଟମ ସଫ୍ଟ ୱେର

B.  A. ଆପ୍ଲି  କେସନ ସଫ୍ଟ ୱେର

C.  D. ପ୍ରୋ ଗ୍ରା ମିଂ  ସଫ୍ଟ ୱେର

D.  B. ଏମ୍ବେଡେଡ ସଫ୍ଟ ୱେର

✓

Q78 Computer
Which shortcut key is used to save a PowerPoint presentation
quickly?

A.  D. Ctrl + N

B.  A. Ctrl + S

C.  C. Ctrl + O

D.  B. Ctrl + P

✓

Q79 Computer
In Normal view, to enter text into a slide you should:

A.  D. View → Slide Master → Insert Text

B.  B. Design → Text Entry

C.  A. File → Edit Text

D.  C. Insert → Text Box → draw box → type

✓

Q80 Computer
ଆପଣଙ୍କ ପ୍ରେ ଜେଣ୍ଟେସନରେ ଥି ବା ସମସ୍ତ ସ୍ଲା ଇଡରେ ଏକ ବ୍ୟାକଗ୍ରା ଉଣ୍ଡ ମ୍ୟୁ ଜି କ ଅଡି ଓ କ୍ଲି  ପ
ପ୍ଲେ  କରି ବା ପାଇଁ  ଆପଣ କ'ଣ କରି ବା ଆବଶ୍ୟକ?

A.  A. Insert → Audio → choose file, then Playback tab → Play
across slides

B.  C. Design → Background Music

C.  D. Slide Show → Loop Music

D.  B. Insert → Text Box → Type music

✓

Q81 Computer
In an e-mail, which part specifies the identity of the recipient?

A.  A. Subject line

B.  C. Header

C.  B. Body

D.  D. Signature

✓

Q82 Computer
କମ୍ପ୍ୟୁ ଟର ଷ୍ଟାର୍ଟ  ଅପ, ହାର୍ଡ ୱେର ମ୍ୟାନେଜ ଏବଂ ଅନ୍ୟ ସମସ୍ତ ପ୍ରୋ ଗ୍ରା ମ ରନ କରି ବା ପାଇଁ
ୟୁ ଜର ଏବଂ ମେସି ନ କମ୍ପୋନେଣ୍ଟଗୁ ଡ଼ି କ ମଧ୍ୟରେ ସେତୁ  ଭାବରେ କାର୍ଯ୍ୟ  କରି ବା ପାଇଁ
କେଉଁ  ପ୍ର କାରର ସଫ୍ଟ ୱେର ଜରୁ ରୀ ଅଟେ?

A.  D. ଆପ୍ଲି  କେସନ ସଫ୍ଟ ୱେର

B.  C. ସି ଷ୍ଟମ ସଫ୍ଟ ୱେର

C.  A. ୟୁ ଟି ଲି ଟି  ସଫ୍ଟ ୱେର

D.  B. ଏଣ୍ଟରଟେନମେଣ୍ଟ ସଫ୍ଟ ୱେର

✓

Q83 Computer
You want to insert a new column between columns B and C without
overwriting existing data. What should you do first?

A.  B. Press Delete on Column C

B.  A. Select Column C and click 'Insert'

C.  C. Select Column B and click 'Insert'

D.  D. Select any cell in Column A and press Enter

✓

Q84 Computer
Which of the following functions is used in MS Excel 2019 to show
the current date?

A.  B. today()

B.  D. now()

C.  C. date()

D.  A. time()

✓

Q85 Computer
ଏକ ଇମେଲର ମୁ ଖ୍ୟ ଭାଗରେ ସାଧାରଣତଃ କ’ଣ ଥାଏ?

A.  D. କେବଳ ପ୍ରା ପ୍ତକର୍ତ୍ତା ଙ୍କ ଠି କଣା

B.  C. ଇମେଲ ଆଟାଚମେଣ୍ଟ

C.  A. ଟେକ୍ସଟ ମେସେଜ ଏବଂ ଦସ୍ତଖତ

D.  B. କେବଳ ସବଜେକ୍ଟ ଲାଇନ
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✓

Q86 Computer
Which feature in MS Word helps create a list with symbols or
numbers?

A.  D. Text Effects

B.  A. Bullets and Numbering

C.  C. Mail Merge

D.  B. Track Changes

✓

Q87 Computer
In Microsoft Word 2019, what is the correct sequence to open an
existing document?

A.  D. File > Save

B.  A. File > New

C.  C. File > Open

D.  B. Home > Paste

✓

Q88 Computer
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ସମୀକରଣ, ସି ଷ୍ଟମ ଏବଂ ଆପ୍ଲି  କେସନ ସଫ୍ଟ ୱେୟାର୍  ମଧ୍ୟରେ
ଥି ବା ଅନ୍ତରକୁ  ସର୍ବୋ ତ୍ତମ ଭାବରେ ଉପସ୍ଥାପି ତ କରେ?

A.  A. ସି ଷ୍ଟମ ସଫ୍ଟ ୱେୟାର୍  ରେ କମ୍ପ୍ୟୁ ଟରର ହାର୍ଡ ୱେର୍  ଉତ୍ସଗୁ ଡି କର ପରି ଚାଳନା
କରୁ ଥି ବା ପ୍ରୋ ଗ୍ରା ମ ଅନ୍ତର୍ଭୁ କ୍ତ, ଯେତେବେଳେ କି  ଆପ୍ଲି  କେସନ୍  ସଫ୍ଟ ୱେୟାର୍  ନି ର୍ଦ୍ଦିଷ୍ଟ
କାର୍ଯ୍ୟ  ପାଇଁ  ବ୍ୟବହୃ ତ ଟୁ ଲ୍  କୁ  ସନ୍ଦର୍ଭିତ କରେ ।

B.  D. ସି ଷ୍ଟମ ସଫ୍ଟ ୱେୟାରରେ ଶେଷ-ଉପଯୋଗକାରୀ (end-users) ଙ୍କ ପାଇଁ
ଡି ଜାଇନ ହୋଇଥି ବା ଆପ୍ଲି  କେସନ୍  ଅନ୍ତର୍ଭୁ କ୍ତ, ଯେତେବେଳେ କି  ଆପ୍ଲି  କେସନ୍
ସଫ୍ଟ ୱେୟାର୍  ଅପରେଟିଂ  ସି ଷ୍ଟମ୍  ଅପରେସନକୁ  ପରି ଚାଳନା କରେ ।

C.  B. ବ୍ୟକ୍ତି ଗତ କାର୍ଯ୍ୟ  ପାଇଁ  ୱାର୍ଡ  ପ୍ରୋ ସେସିଂ  ଏବଂ ସ୍ପ୍ରେଡସି ଟ୍  ଭଳି  ସି ଷ୍ଟମ
ସଫ୍ଟ ୱେୟାର୍  ବ୍ୟବହୃ ତ ହୁ ଏ, ଯେତେବେଳେ କି  ଆପ୍ଲି  କେସନ୍  ସଫ୍ଟ ୱେୟାର୍  କମ୍ପ୍ୟୁ ଟରର
ଅପରେଟିଂ  ସି ଷ୍ଟମ୍  ପରି ଚାଳନା କରେ ।

D.  C. ସି ଷ୍ଟମ ସଫ୍ଟ ୱେୟାର୍ , ମେନଫ୍ରେ ମରେ ବ୍ୟବହୃ ତ ସଫ୍ଟ ୱେୟାର୍  କୁ  ସୂ ଚି ତ କରେ,
ଯେତେବେଳେ କି  ଆପ୍ଲି  କେସନ୍  ସଫ୍ଟ ୱେୟାର୍  ବ୍ୟକ୍ତି ଗତ କମ୍ପ୍ୟୁ ଟର ପାଇଁ  ଏକ୍ସକ୍ଲୁ ସି ଭ
ଅଟେ ।

✓

Q89 Computer
What does the abbreviation BIOS stand for?

A.  B. Basic Input/Output System

B.  D. Basic In/Out System

C.  A. Basic Input/Output Services

D.  C. Basic In/Out Services

✓

Q90 Computer
ଯଦି  ଆପଣ ପ୍ଲେ ସେସ ବକ୍ସରେ 3 ଏଣ୍ଟର କରନ୍ତି  ଏବଂ ତାପରେ MS ଏକ୍ସେଲ ସ୍ପ୍ରେଡସି ଟର
ଏକ ସେଲରେ 2834 ଟାଇପ୍  କରନ୍ତି , ତେବେ ଫଳାଫଳ କେତେ ହେବ?

A.  B. 283400

B.  A. 002834

C.  C. 2834.00

D.  D. 2.834
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Reasoning

✓

Q91 Reasoning
ସାତ ଜଣ ବ୍ୟକ୍ତି  X, Y, Z, R, S, T ଏବଂ U ଦକ୍ଷି ଣ ଦି ଗକୁ  ମୁ ହଁ  କରି  ଗୋଟି ଏ ଧାଡି ରେ
ବସି ଛନ୍ତି  । S କୌଣସି  ଏକ ପ୍ରା ନ୍ତରେ ବସି ଛନ୍ତି  । S ଙ୍କ ଡାହାଣ ପାର୍ଶ୍ୱ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ Z
ବସି ଛନ୍ତି  । X ଓ Z ଙ୍କ ମଧ୍ୟରେ କେବଳ Y ବସି ଛନ୍ତି  । T ଙ୍କ ଠି କ ବାମ ପାର୍ଶ୍ୱ ରେ R ବସି ଛନ୍ତି  ।
ଡାହାଣ ପ୍ରା ନ୍ତରୁ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ କି ଏ ବସି ଛନ୍ତି ?

A.  A. X

B.  D. R

C.  C. Z

D.  B. T

✓

Q92 Reasoning
In a certain code language,
‘A + B’ means ‘A is the mother of B’,
‘A − B’ means ‘A is the sister of B’,
‘A % B’ means ‘A is the wife of B’ and
‘A $ B’ means 'A is the brother of B’.
If ‘N + S − P % M $ K’, how is N related to K?2437

A.  B. Sister's husband's mother

B.  D. Brother's wife's mother

C.  A. Husband's mother

D.  C. Brother's mother

✓

Q93 Reasoning
ସାତଟି  ବାକ୍ସ I, J, K, L, W, X ଏବଂ Y, ଗୋଟି ଏ ଉପରେ ଗୋଟି ଏ ରଖାଯାଇଛି  କି ନ୍ତୁ ସମାନ
କ୍ର ମରେ ରଖି ବା ଜରୁ ରୀ ନୁ ହେଁ  । I ଉପରେ କୌଣସି  ବାକ୍ସ ରଖାଯାଇ ନାହିଁ । I ଏବଂ Y
ମଧ୍ୟରେ କେବଳ ତି ନୋଟି  ବାକ୍ସ ରଖାଯାଇଛି  । K ଏବଂ J ମଧ୍ୟରେ କେବଳ ଗୋଟି ଏ ବାକ୍ସ
ରଖାଯାଇଛି  । J କୁ  Y ର ଠି କ ଉପରେ ରଖାଯାଇଛି  । K ଏବଂ W ମଧ୍ୟରେ କେବଳ ଚାରୋଟି
ବାକ୍ସ ରଖାଯାଇଛି  । X କୁ  L ର ଉପରେ କୌଣସି  ଏକ ସ୍ଥାନରେ ରଖାଯାଇଛି  । X ତଳେ
ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ କେଉଁ  ବାକ୍ସ ରଖାଯାଇଛି ?

A.  A. I

B.  B. K

C.  C. L

D.  D. Y

✓

Q94 Reasoning
Select the pair which follows the same pattern as that followed by
the two set of pairs given below. Both pairs follow the same pattern.
EFN : AKS
WPX : SUC

A.  B. UKM : ROQ

B.  A. ZRX : UVB

C.  C. WAS : SEW

D.  D. OZH : KEM

✓

Q95 Reasoning
ଯଦି  ସଂଖ୍ୟା 8714356 ର ପ୍ର ତ୍ୟେକ ଅଯୁ ଗ୍ମ  ଅଙ୍କରେ 1 ଯୋଗ କରାଯାଏ ଏବଂ ପ୍ର ତ୍ୟେକ
ଯୁ ଗ୍ମ  ଅଙ୍କରୁ  2 ବି ୟୋଗ କରାଯାଏ, ତେବେ ଏହି ପରି  ଗଠି ତ ନୂ ତନ ସଂଖ୍ୟାରେ କେତୋଟି  ଅଙ୍କ
ଏକାଧି କ ଥର ଦେଖି ବାକୁ  ମି ଳି ବ?

A.  C. କୌଣସି ବି  ନୁ ହେଁ

B.  B. ଏକ

C.  D. ଦୁ ଇ

D.  A. ତି ନି

✓

Q96 Reasoning
ପ୍ର ଦତ୍ତ ଅନୁ କ୍ର ମକୁ  ତର୍କ ସି ଦ୍ଧ ଭାବେ ସଂପୂ ର୍ଣ୍ଣ  କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ଅକ୍ଷର-ସଂଖ୍ୟା ପୁ ଞ୍ଜ
ମଧ୍ୟରୁ  କେଉଁ ଟି କୁ  ପ୍ର ଶ୍ନ ଚି ହ୍ନ (?) ସ୍ଥାନରେ ପ୍ର ତି ସ୍ଥାପି ତ କରାଯାଇପାରି ବ?

MEH 7 PGG -14 SIF 28 VKE -56 ?

A.  A. MJU 231

B.  C. YMD 112

C.  D. GTR -111

D.  B. NHU -651

✓

Q97 Reasoning
In a certain code language, ‘urn olive egg’ is coded as 'gv nm nv' and
‘input urn news’ is coded as ‘nm vh hd’. How is ‘urn’ coded in that
language?

A.  D. vh

B.  C. nv

C.  A. nm

D.  B. gv

✓

Q98 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ଅକ୍ଷର-ପୁ ଞ୍ଜ ମଧ୍ୟରୁ  ତି ନୋଟି  ଏକ
ନି ର୍ଦ୍ଦିଷ୍ଟ ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ଏବଂ ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି  । କେଉଁ  ଅକ୍ଷର-ପୁ ଞ୍ଜ
ସେହି  ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ ?
(ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟତା ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ ର ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର-ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର
ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ ନୁ ହେଁ  ।)

A.  D. MXC

B.  B. NYD

C.  A. OZE

D.  C. PAS
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✓

Q99 Reasoning

Read the given statement(s) and conclusions
carefully. Assuming that the information given in
the statements is true, even if it appears to be at
variance with commonly known facts, decide
which of the given conclusions logically follow(s)
from the statement(s).

Statements:
All jars are cats.
All cats are mugs.

Conclusion (I) : Some mugs are cats.
Conclusion (II) : All jars are mugs.

A.  A. Both conclusions (I) and (II) follow

B.  C. Neither conclusion (I) nor (II) follows

C.  B. Only conclusion (II) follows

D.  D. Only conclusion (I) follows

✓

Q100 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ । (ସମସ୍ତ ସଂଖ୍ୟା କେବଳ ଏକ-ଅଙ୍କ
ବି ଶି ଷ୍ଟ ସଂଖ୍ୟା ଅଟେ । ଗଣନା କେବଳ ବାମରୁ  ଡାହାଣକୁ  କରାଯି ବ ।)

(ବାମ) 6 2 9 3 5 4 6 9 2 5 8 4 8 7 4 2 5 7 9 4 1 3 6 2 8 4 5 7 1 (ଡାହାଣ)

ଏପରି  କେତୋଟି  ଯୁ ଗ୍ମ  ଅଙ୍କ ଅଛି , ଯାହାର ପ୍ର ତ୍ୟେକର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ଅଯୁ ଗ୍ମ  ଅଙ୍କ ଅଛି  ଏବଂ
ଠି କ ପରେ ଏକ ଯୁ ଗ୍ମ  ଅଙ୍କ ମଧ୍ୟ ଅଛି ?

A.  D. ତି ନି ରୁ  ଅଧି କ

B.  B. ଏକ

C.  C. ଦୁ ଇ

D.  A. ତି ନି
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